Gestores bibliograficos

Biblioteca de |la Facultad de
Optica y Optometria



o\-@ UNIVERSIDAD COMPLUTENSE

"é* % BIBLIOTECA

OPTICA Y OPTOMETRIA ~

7 " @
r .‘ A
Buscar mas Bira Catdaloge Cisne (&3 ~CJJ Q

s Articulos 4 Colecciones-e ‘
+ E-Prints 4 Cishe BUCea Buscar MiCuenta  Cursos  Coleccién

Servicios t

. -
« Préstamo « Investigacion E-Prints @ z
« Formaicion « Mi cuenta T Libros, revistas, tesis, bases de datos, rmatehcles >

Articulos S ; : A
IS n audiovisuales etc., suschtos o localizados en la Universidad

e Opf Blog Exposiciones
Bibliotecas 25 UNIVERSIDAD COMPLU

BIBLI()TE(_“A CAMPUS DE

. EXCELENCIA
OPTICA Y OPTOMETRIA \ ¢ INTERNACIONZ

Buscar mds ' Portadas Condcenos v Formacidny Guios

e ™ Formacién y Guias

Ayuﬁu s E-Frints « Cizshe

« Carné (Sugerencics + Servicios +

o Wifi s Présztornos « Investigacidn

Cursos de la Biblioteca de Optica y Optometria (2014-2015) Pautas para elaborar un
Trabajo cientifico

« Farmacidn « ki cuenta

* fiblioteca de la Focultod de Gptica y Optometia: arganizacian, recorsos, senvicios

I

s Plantilla-guia para =laborar un
* |ntroduccion alas fuentes de informacion en dptica ¥ optpmetia; bases de datos y recursos en Trabaojo de Fin de grodo o

internet Midster  [Martinez  Ordefiez
Maria Luiza; Willar Garcig -
Morene, Gumersinde v Romero

Bibliotecus

« Bibliotecoa Complutense

Condcenos

0
I

©  Encuesta de satisfaccion del curso recibido

« Fondos « Servicios ® glsqueda y elabaoracién de bibliografias: bases de datos y gestares bibliograficas

. . .. Cabyo, Francizeo
s« Tutoricles « Direccion . e L
@ Epcuesta de satisfaccion del curso recibido [20] 3] Pllﬂ'ﬂﬁllllﬂ'-gUFO' para o
Ayuda ¥ elaboracidn de las memorias
de Sistermos
» COrné s Sugerencics « FAG . . ;
Wi nformdticos Trabajos de Fin de
Grodo v Mdater)

Gestores bibliogrdficos

[ vio de diferentes gestores biblicardfices [Biklioteca * Preparar y elaborar un trabaio

Complutense en Moodie) acadamice  [Martinez,  Luis

Javviar [2013]: Cémo buscar v
* Acceso enlineda o RefiWaorks vsar  fonmacion  clientifica:
guia felelge] estudicantes

* Apoeso en lihes o Bodnote ek o Goio bdsicn porg el u:o de Bdnote [Thomson uRiversitanios)

Reuters]

* Recomendaciones para

¢ BExportacidn de datesz en Endnote [2009] dact bl Fieul
redactar v pubklicar articulas



GESTORES BIBLIOGRAFICOS

> Permiten crear, organizar, buscar y dar
forma las referencias bibliograficas,
facilitando la incorporacion de citas y
referencias en los manuscritos, utilizando
distintos “estilos” (Vancouver, AMA,
APA...)

> Ejemplos: ENDNOTE, PROCITE,
REFWORKS, Zotero, Mendeley ...




A C g

Increased Expression of IL-22 Is Associated with Disease Activity in Behcet's Disease
Tao Cai, Qian Wang, Qingyun Zhou, Chaokui Wang, Shengping Hou, Jian Qi, Aize Kijlstra, Peizeng Yang

had no role in study design, data collection and analysis, decision to publish, or preparation of

the manuscript.

ki

Abstract

Introduction

Materials and Methods
Results

Discussion Introduction

Acknowledgments Interleukin (IL}-22. a

Author Contributions
IL-22 mediates its effés
heterodimeric receptor IL-22RT, wl

and fibroblasts. [2], [5] Upon binding to its
responses and has been shown to induce |
fibroblasts and osteoclasts in rheumatoid a
IL-22 may be involved in the pathogenesis «
disease (CD), rheumatoid arthritis (RA), Sj
erythematosus (SLE). [8]-[12] Earlier studi Materials and Metho
by PBMCs from noninfectious uveitis patier  pasuis

References

Reader Comments (0)
Figures
g Abstract

Introduction

. . . - Discussion
IL-22 is also involved in the survival of cells

protective effect besides its proinflammator
be protective against experimental hepatitis

Acknowledgments
+ Author Contributions
References
Behcet's disease (BD) is a chronic system
uveitis, oral aphthae, genital ulcers, and sk
unclear, several reports have suggested th:
role. Recent studies from our group have s
disease. [18] As yet. it is not clear whethe
involved in this disease. The study present:
IL-22 in BD, and it"s association with clinic
associated with the activity of BD and the «¢
it may be involved in its pathogenesis.

Reader Comments (0)

Figures

Materials and Methods

% | Error en la pagina.

Competing interests: The authors have declared that no competing interests exist.

perfamily, is primarily produced by activated T cells
and natural killer (M) cells. [1]-[2] It is oftgn secreted together with IL-17 by Th17 cells. [3]-[4]

SH. Analyzed the data: TC JQ. Contributed reagemsfmaterialsp’analy‘ls\s tools: PY. Wrote the
paper: TC AK PY.

References

w

~

o

o

=

=)

w

=

[

. Dumoutier L, Louahed J, Renauld JC (2000) Cloning and characterization of IL-10-

related T cell-derived inducible factor {IL-TIF), a novel cytokine structurally related to IL-
10 and inducible by IL-9. J Immunol 164: 1814-1819. Find this article online

Wolk K. Kunz S, Witte E, Friedrich M, Asadullah K, et al. (2004) IL-22 increases the
innate immunity of tissues. Immunity 21: 241-254_ doi: 10.1016/j.immuni 2004 07 007.
Find this article online

Liang SC, Tan XY, Luxenberg DP, Karim R, Dunussi-Joannopoulos K, et al. (2006)
Interleukin (IL}-22 and IL-17 are coexpressed by Th17 cells and cooperatively enhance
expression of antimicrobial peptides. J Exp Med 203: 2271-2279. doi:
10.1084/jem_20061308. Find this article anline

Chung ¥, Yang X, Chang SH, Ma L, Tian Q, et al. (2006) Expression and regulation of
IL-22 in the IL-17-producing CD4+ T lymphaocytes. Cell Res 16: 902-807. doi:
10.1038/sj.cr.7310106. Find this article online

Waolk K. Kunz S, Asadullah K, Sabat R (2002) Cutting edge: immune cells as sources
and targets of the IL-10 family members? J Immunol 168: 5397-5402. Find this article
online

Ikeuchi H, Kuroiwa T, Hiramatsu M, Kaneko Y, Hiromura K, et al. (2005) Expression of
interleukin-22 in rheumatoid arthritis: potential role as a proinflammatory cytokine.
Arthritis Rheum 52: 1037-1046. doi- 10.1002/art 20965 Find this article online

Kim KW, Kim HR, Park JY, Park JS, Oh HJ, et al. {2012) Interleukin-22 promotes
osteoclastogenesis in rheumatoid arthritis through induction of RANKL in human
synovial fibroblasts. Arthritis Rheum 64: 1015-1023. doi: 10.1002/art.33446. Find this
article online

Kagami S, Rizzo HL, Lee JJ, Koguchi Y, Blawelt A (2010) Circulating Th17, Th22, and
Th1 cells are increased in psoriasis_ J Invest Dermatal 130: 1373-1383. doi:
10.1038/jid_2009.399. Find this article online

Colin EM, Asmawidjaja PS, van Hamburg JP, Mus AM, van Driel M, et al. (2010) 1,25-
dihydroxyvitamin D3 modulates Th17 polarization and interleukin-22 expression by
memaory T cells from patients with early rheumatoid arthritis. Arthritis Rheum 62: 132—
142. doi: 10.1002/art.25043. Find this article online

. Brand S, Beigel F, Olszak T, Zitzmann K, Eichhorst ST, et al. (2006) IL-22 is increased

in active Crohn's disease and promotes proinflammatory gene expression and intestinal

Ji.| Errar en la pagina.

Q’ @ Inkernet

5 -

#100%



http://www.plosone.org/article/info%3Adoi%2F10.1371%2Fjournal.pone.0059009

Gestores bibliograficos

> WEB of Science Y ENDNOTE WEB

o« DIRECTAMENTE EN LA DIR.
WWW. myendnoteweb.com

o HTTR://MWWW.ACCESOWOK.FECYT.ES

« DESDE LA BUC

http://www.accesowok.fecyt.es/login/
http://cisne.sim.ucm.es/search*spi—S12



http://www.myendnoteweb.com/
http://www.accesowok.fecyt.es/
http://www.accesowok.fecyt.es/login/
http://cisne.sim.ucm.es/search*spi~S12

Cambiar Idio

InCites ™ | Jowrnal Citation Reports® | Essential Science Indicators ™ EndNote ™™ Marha JesA s Help | English
Pl i r"-_' -
) L N THOMSON REUTERS

Search All Databases |~ My Tools Search History = Marked List

Welcome to the new Web of Science! View a brief tutorial.

Basic Search

] Click here for tips to
Topic e improve your search.

+ Add Another Field Reset Form

TIMESPAN

® | Allyears ~

O From | 1900 ~ | to | 2014 |~




GESTORES BIBLIOGRAFICOS:
EndNote Web

> Registrarse
o« Comun para Web of Science y EndNote Web

o« Campos obligatorios los marcades con
asterisco:
No utilizar acentos, guiones ...

Password de 8 caracteres gue debe contener 1
numerico, otro alfabetico y un simbolo especial

(€- 2@ ()1} %S *#)
o Al finalizar pulsar SUBMIT REGISTRATION



User Registration

Please complete the fields below. Fields with an asterisk are required.

* E-mail Address: rachaelmangan@yahoo.co.uk )
| Nombre sin

acentos ni
guiones

*FirstName:|

*LastName:|

Middle Initial: |:|

*Passwnrd:| |

Dseurord Guidelines La contrasefa — deberia ser

i J

Must be 8 or more characters (no spaces) and contain: por IIO menos 8 CgrathereS’ de
- atleast1 numeral: 0- 9 ,O_S que uno de ,e_ ser
- atleast 1 alpha character, case-sensitive numerico, otro alfabetlco\y otro
- atleast symbol L@#§ %A% ()~ {1111 &_ un simbolo (!@#$%"*()~ {}]|\ )

Example: 1sun%maan

* Retype Passward: | | *Seleccione un trabajo principal (si no

*Primary RolefTitle: | Select.., v| / aparece en la lista seleccione ‘other’)

* Subject Area: | Select... *Seleccione un area de investigacion (si
Bibliographic Software Use: | Select... v no aparece en la lista seleccione
‘other’)

T OptinfOptout O Send me information about Thomson Reuters products and services related to 151 Web of Knowledge.

O Do not send me information about Thomson Reuters products and services related to 151 Web of Knowledge.

Autamatic Sign In > 7 Sign me in automatically.
(Selectthis ifyou want to be signed in automatically each time you access 151WWeh of Knowledge. This feature uses cookie
technology.)
® 1am using a public camputer or do notwish to he signed in automatically.
(Users of public computers should select this option.)




Abrir EndNote

InCites ™ | Journal Citation Reports® | Essential Science Indicators =M @ MarAa JesA®s Ayuda | Espanol

WEB OF SCIENCE™ THOMSON REUTERS"

Buscar Todas las bases de datos |~ Mis herramientas Historial de busqueda  Lista de registros marcados

Busqueda basica

+ Agregar otro campo Borrar todos los campos

PERIODO DE TIEMPO

Todos los afios |~

1900 =~ | hasta | 2015 =~




EndNote Web

Sign In or create an account

E-mail:

1]

Password:

— -

O Keep me signad in

Institutional/ Shibboleth: Sign in via your institutional lagin

Tnj EndHote desktop out for 30 days, we think you'll like it.

anywhere, on your desktop and online.

& 2015 THO

Lt

EUTEAS Mabill= Sit= | Privac

Halp

THOMSON REUTERS®

Find

Find the best potential journal to publish your research.

Store

COrganize and group references in any way that wo

u Write to oreate and format you

Share your research and references with colleagues.

Connectte=

Interact and network with researchers arcund the world.




ResearcherlD

Web of Science™

Mis referencias Recopilar

Busqueda rapida

=L | Trelm= mi= e fmrmmcin

Buscar

Mis referencias
Todzs mis rafarancles (42¢)

[Sin arenar )
Lista rapia (1)

Papslera (257) Vacio

W iz grupos
12-03-2013 (53)
o013 @ A4
aratemia (1)
aennnz s5) A8
astigmattsma (5)
Castrose (13)
Docora (37) A%
£ (3)
Efman (1)
Gema (3)
GIEUCM ¥ DoiECkN (241

basic

Crrganizar

Todas mis referencias

7L Tada DPa’gina Copiar a la lista rapida = El

Autord

Aplicar formato

Ao

19594

Coincidencia Opciones

Le damos |a bienvenida, Marfa Jesh®s

THOMSON R

Conectar™

Mastrar Gu

Referencias
importadas

Mo msgra[ ez It M MAS IN|

Ordenar por:|erimer awar — &2
Titulo

Procedimientos clinices en el examen visual
Agregada a la biblioteca: 13 Feb 2014 Omima actualizacsn: 25 Nov 2014
r1& o Otros recursos

El examen visual en el paciente diabético [Recurso electranica]
Agregada a la biblioteca: 13 Feb 2014 Omima actualizacsn: 25 Nov 2014

e vl Otros recursos

MWeuron glia biclogy
Meuran Glia Biol
BAgregada a la biblloteca: 12 Nowv 2014 (ttima actualzacksn: 12 Nowv 2014

e v Otros necursos

Goodman & Gilman: las bases farmacoldgicas de |a terapéutica [12a. ed.)
Agregada ala biblioteca: 21 Nov 2014 Omima actuaizacién: 12 May 2015
Vincule en linga Irala URL

e vl Otros recursos




EndNote

> Mis referencias

> Recoplilar
o Incorporar referencias

> Organizar

o Crear y organizar grupos de referencias, eliminar
duplicados...

> Formato
o Crear bibliografias segun distintos formatos...

> Coincidencia

o Ayuda a seleccionar revistas en donde publicar el
articulo



> Incorporar referencias/Collect

o 1.BUsqueda online en bases de datos DESDE
EndNote

o 2.INntroducir referencias manualmente

o 3.Importar registros desde ficheros creados
en las bases de datos/catalogos



Incorporar referencias

EZ Microsoft PowerPoint - [Gesiores bibliogrdficos. ppt K | *|
P oel Ho B B 3 by ) | R

2 § 1= | S g =N ~ | L . I = A = Estilo | Wuewa dispositiva...

/= EndNote Web 2.5 - Windows Internet Explorer _”:l |§| =

Epy http:fiendnote. accesowok. Facyt . es/EndMotetweb/2.5ireleass/Endhoteiweb collectafunc—remoteSearchConnectionsa

Archiva  Edicidn  Wer Favoritos  Herramientas  Ayuda
A A - R - [5) reane - i -@- &
e TZ¥ Pégina ~ {0 Herramientas 'y

Welcome Maria Jesu: 1 web of Knowledge= | Log Out | Help

EndNo

by ISI Web of

My References Collect Organize Format

Online Search | Mew Reference | Import References

Online Se
Step 1

Select database or library cata ~annection.

Customize this list Busqueda online en bases de datos desde Endnote

Aalborg U

Aarhus Kommunes Biblio
Amrhus U

Abbot PL

Aberystenyth U

Abilene Christian U
Abilene Lib Consortium

Permite guardar hasta 25 conexiones favoritas

Cruses Firenze
Adams st Coll

Adler School Brof Psy
Administrative Eib
Afton FL

Ag Esp de Coop Intl
Agawam PL
Agricultural U of Athens
AIATSIS

Alear U HF

Alcarshus fb

Akron CO PL

Alameds County BL
Alzme CC

Albany St U .
Albertz Seo Survey Privacy | Acceptable Use | Download Installars | Feedback

Albertas Govt Lib
= 2009 THOMSOMN REUTERS

THOMSOMN REUTERS

& &P Internet

== =8

onda spafiol (Espafia - alfab. internacianal

- | 2




EndNote Web

__ Estilo | Mueva diapositiva..

s/Endhatevweb) 2. 5ireleass/EndMotetweb. htmizcat—collectafun

wer  Favoritos  Herramientas  Ayuda

T G Eéa s Qpéglna - ~£}$ Herramientas ~ @- ﬁ ;
me Maria Jesus
dNote"
enaiote) .-

My References Collect Organize Format Options

Online Search | MNew Reference | Import References

Online Search
Step 1
Select database or library catalog connection.
| Customize this list

Wiews in

Privacy | Acceptable Use | Download Installers | Feedback
= 2009 THOMSOMN REUTERS

THOMSON REUTERS
-~

.JEndraoteweb. heml?Func=remoteSearchConnect [ &P Internet L 100% -
= = ™

oo Mastrar sl inssrt
[ES|iEER=S

& Do + [15 ] Atoformas = S s [ O 5 <l £ (@] (& | On - - a =l
Diapositiva 12 de 12 Onda Eparell{Esparial-ialFabylinksrnacional

B e T o Explorer ~|




Hemos seleccionado PubMed

.accesowok.Fecyt. esfEndhotevweb/2 . Sirelease/EndioteWeb. html?Func=remoteSearchConnect

wer Favoritos  Herramientas  Asyuda
= - ;%' Pagina = 4CF Herramientas ~ @v = P

- A diseii
ome Maria Jesus 1SI Web of Knowledge= | Log out | Help de diapositiva:

Diserios o
EndNote™ M
provided by

IS Web of Knowledge™

My References Collect Organize Options

online search | MNew Reference Import References

Online Search Ijl

Step 2 of 3: Connecting to PubMed MEDLINE : PubMed (NLM)

[rRamire= in:  [Author (Smith AE) ~| [and >

[retina i [and ]
| _ s Desplegar campos de busqueda

»
»

Disefios
de

Page Numbar objetos

Keywords (MeSH)
MaSH Major Topi

FParsonal Name == Subject
Abstract

Language

Subheading

Corporate Name

Subtance Name

Bublication Type

Puklication Dats

Date Entered (yyyy/mmidd)
Entsred Betwasn (datel:datsz)
MeSH Date

EC/RMN Mumber

Wiews in

Privacy | Acceptable Use | Download Installers | Feedback

= 2009 THOMSOMN REUTERS

THOMSON REUTERS

& &P Internet Y 100%

~ |H=ga clic para agregar notas

Autaformas ~ N w1 O Bl r @] G| Sy - e - == a0

Onda spafiol (Espafia - alfab. internacianal




¢~ 1S| Web of Knowledge [v.4.5] - All Databases Home - Windows Internet Explorer

& httpi/fsauwok.Fecyt. esfappsfUA_GeneralSearch_input. do?preferences Saved=aproduct=UARSID=X250%40sFF SnHbES %40F 90 adssarch_mode=Gener alSearch

¢= EndMNote Web 2.5 - Windows Internet Explorer

_;: Bpg httpiffendnote . accesowok.Fecyt. es/Endioteiweh)z,. 5/release/Endiotetweb . html?func=remoteSearchRangeselectionfnemwSear ch=yestauth=

Archivo Edicidn Mer Fawvoritos Herrarmientas Ayuda
i e - B} - b - |5 rigine - 03 Horremiontes - (@D L 33

Welcome Maria Jesus I1SI web of Knowledge= | Log Out | Help

EndNo

by ISI Web of

My References Collect Organize Options

Online Search P Mew Reference Import References

Online Search

Step 3 of 3: Connecting to PubMed MEDLINE : PubMed (NLM)
((Ramirez) in Author {(Smith AB)) and ({retina) in Any Field)

ound 79 results:

through |73

Pulsar “Retrieve” para ver los registros

Wiews in

Privacy | Acceptable Use | Download Installers | Feedback
= 2009 THOMSOMN REUTERS

THOMSOMN REUTERS

[ € nternet

« Sign-up/Access my
ResearcherlD

T TS T S ST T

[ &P Internet

< Inicio 5 9 Intern




Una vez recuperadas las referencia hay que senalar las que se guiere
guardar y moverlas al grupo de referencias, utilizando el desplegable
“Add to group”

EZ Microsoft PowerPoint - [Gestores bibliogréficos. ppt
e el T B T 3 Y b | R

/= EndMote Web 2.5 - Windows Internet Explorer

Jiendnote. accesowok. Fecyt. esfEndioteweb(z, 5 release/Endhotewweb, himlzfunc=remoteSearchSummar yBnewSe arcl

archive Edicién Wer Favoritos Herramientas Ayuda

e A - EY - o - [ reane - 558 Heramiontas - (@) B -

E‘!’!ﬂd N o Web

by ISI Web of Knowledge™

My References Collect Organize Options

Online Search i MNew Reference i Import References

Online Search Results
PubMed MEDLINE 1 - 10 of 59 results
{{(Ramirez) in Author (Smith AB)} and ({retina) in &ny Field)

[Show 10 per page [+] H (GoD ! =& (0 (Retrieved 59 out of 79)

O all {s9) [Crage
Author Year Copied Title
de Hoz, R 2008 -

Substance P and calcitonin gene-related peptide intrinsic choroidal neurons in human choroidal whole-
mounts.
Histol Histopathol
Online Link= Go to URL
Sanabria, P P2Y¥ 2 receptor desensitization on single endothelial cells.
Endothelium
Online Link=+ Go to URL
Ramirez, 1M [Implications of astroglia in glaucomatous damage]
Arch Soc Esp Oftalmol
Online Link= Go to URL
Ramirez, DM Meuronal expression and subcellular localization of cholesterol 24-hydroxylase in the mouse brain.
J Comp MNeurol
Online Link= Go to URL

Ul £ehyes,

Pérez-Alvarez, MJ Vimentin isoform expression in the human retina characterized with the monoclonal antibody 3CEB2.
J Meurosci Res
Online Link= Go to URL

~

[ € nternet # 100% -

] Haga clic para agregar notas

Mastrar al insert
Auroformas = N = [ O 2]l 2 (2] L8l | Dy - w - ca =l

onda spafiol (Espafia - alfab. internacional 153

A= 9 Internet ... i E: oo (- —




2. Crear referencias manualmente

> New references

o Seleccionar el tipo de documento a introducir
(articulo de revista “journal article”, capitulo
de libro “book section™...)

o Incorporar los datos del registro en las cajas

Autores: separar apellido de la inicial del nombre
POr coma Yy entre los autores por punto y coma

Keywords deben separarse por coma
Guardar con “Save”



3. Importar referencias de busguedas en bases de datos
desde fuera de EndNote

> PubMed

o Ir a PubMed y realizar la busqueda y guardar
en formato Medline (opcion display) y guardar
en un fichero “send to File”



Pubmed{gou

US Mationsl Librany of Medicine

Mational Institutes of Health

Show additional filters

Desde PubMed

Sign in to NCBI

| PubMed

h | |deve|0pmer‘|t mouse rat

Display Settings: Summary, 20 per page, Sorted by Recently Added

|

EJ RSS Sawve search Advanced

Article types
Clinical Trial
Review

maore ...

Text

availability

Abstract available
Free full text available
Full text available

Publication
dates

5 years

10 years
Custom range...

Species
Humans
Other Animals

Clear all

Show additional filters

Results: 1 to 20 of 22530 P

1.

Cathepsin K Is Involved in Development of Psoriasis
TLR-Dependent Th17 Activation.

Hiral T, Kanda T, Sato K, Takaishi M, Nakajima K, Yar
Digiovanni J, Sano S.

Jimmunol. 2013 Mar 29 [Epub ahead of print]

PMID: 23543761 [PubMed - as supplied by publisher]
Related citations

Development and Aging of the Kisspeptin-GPRS4 S
What are the Impacts on Female Reproductive Functi
Franceschini |, Desroziers E.

Front Endocrinol (Lausanne). 2013;4:22. doi: 10.3389fendo 2

PMID: 23543285 [PubMed - in process]
Related citations

Magnefic resonance mMICroscopy.
Badea A, Johnson GA

Stud Health Technol Inform. 2013;185:153-84.
PMID: 23542935 [PubMed - in process]
Eelated citations

Choose Destination
@ File

O Collections

O Order

> Citation manager

Download 22530 items.

Format
| Summary (text) |

Summary (text)
Abstract (text

XML
PMID List
cswv

2 Clipboard
O E-mail
My Bibliography

Send to: Filters: Manage Filters

Download CSW

search terms =

ell types and numbers
eart Circ Physiol. 2007]

B transgenic mouse
[Int J Pancreatol. 1999]

Antisense Oligonucleotide Inhibition of Apolipoprotein C-lll Reduces Plasma

Triglycerides in Rodents, Monhuman Primates. and Humans.

Graham MJ, Lee RG, Bell TA 3rd, Fu W, Mullick AE. Alexander V.J, Singleton W,

Viney M, Geary R, Su JQ, Baker BF, Burkey J, Crooke ST, Crooke RM._

Circ Res. 2013 Mar 29. [Epub ahead of print]

PMID: 23542598 [PubMed - as supplied by publisher]
Eelated citations

Small-molecule inhibitors of the cystic
fibrosis transmembra [Diabetologia. 2013]

See more...

3583 free full-text articles in
PubMed Central

Catalytic nanoceria are preferentially
retained in the rat retin [FLoS One. 2013]

p53 Gene Targeting by Homologous
Recombination in Fish [PLoS One. 2013]

AQP4-Dependent Water Transport Plays
a Functional Role in E» [PLoS One. 2013]

See all (3583)...

Catalytic nanoceria are preferentially retained in the rat retina and are not cyiofoxic Find related data —

& Internet h v E100% <




= C

.-_/.: retina) AMD [(Ramirez[Auth]) - PubMed Resulis - Windows Internet

govisitesfentrez

Epy http:fiendnote. accesowok. Facyt.es/Endhoteweb/2. Sireleass/EndMotesweb. html

Herramientas  Ayuda
s 3 -~ SOy = - ;3
z } Pagina 4% Herramientas @ i:j &

welcome Maria Jes:

archive Edicién Wer Favoritos

& # -5

151 Web of Knowledge= | Log Out | Help

EndNote™

provided by IS] Web of Knowledy
Collect Organize Options

Import References

My References
Online Search | MNew Refersnce

Import References
79 references were imported into "[Unfiled]".

Importing from EndMote? )
File: [EnBocsments and Setingstrmwis d(Emmmmn) Buscar el fichero guardado

Filter: Select... s iIstomize this list
e | e )] Seleccionar el filtro de importacion segin la base de

: datos desde la que se ha descargado

Pro_eedlng=F|r=t ( ocl_c.
ProCite RIS
ProQuest

SeleeCionar a donde “to” y marcar “import”

Privacy | Acceptable Use | Download Installers | Feedback
@ 2009 THOMSOMN REUTERS

Pl
FezdersGuidefbs ( g
bt

THOMSON REUTERS
[ € nternet # 100% -

of vascular =
Ramon Castrowvi
University, Madrid, Spain.

&P Internet

de Hoz, R

lation.
Institute for Cphthalmic Research, Complutense

Listo

- — :
< Inicio = @

>




Seleccionar el filtro de importacion
Medline PC

Web of Science™ ResearcherlD Welcome MarAa JesA®s

baSiC THOMSON REUTE

My References Collect Organize Format Match “= Options Connect®™*

Online Search Mew Reference Import References

Import References

Imparting from EndMota?

==
Import Option: Select Favarites

Tao:

MEDLIME (PL)

PSYNDEXphus Tests {OvidSF)
PubMad [NLM)

RmfMan RIS

RIS-Tilter

Yal= U




Exportar referencias desde Google

Acadéemico

Systematic analysis of E-, N-and P-cadherin expression in mouse eye development Texto completo UCM
L ¥u, PA Oyerheak W Renskar - Fynenmental awe research 2002 - Flasuear

Cadherins al W

hornophilic k .

maintenance Citar

Citado por 9

Copia y pega una cita con un formato especifico o utiliza uno de los enlaces para importar
informacidn a un gestor de bibliografia.

Anterior man nih.gov [HTML]
S%R OSSN Cveld, A, & Tamm, E. R. (2004). Anterior eye development and ocular Texto completo UCM

Ve, mesenchyme: new insights from mouse models and human diseases.
SEiEEILT Bioessays, 26(4), 374-386)
surface epith
pr_edomlnant S0 690 CWVEKL, Ales; TAMM, Ernst R. Anterior eye development and ocular
Citado por 1 mesenchyme: new insights from mouse models and human diseases.

. Bi . 2004, vol. 26, no 4, p. 374-386.
A reqguiren foessays v nos.p yand cship.org [PDF]
eye. MLA - Cvekl, Ale, and Emst R. Tamm. "Anterior eye development and ocular
AT Dudley, | mesenchyme: new insights from mouse models and human diseases.”
... abnarmali Bioessays 26.4 (2004): 374-386.
(Sey) locus
Citado por 8 Importar al BibTeX jmportar al EndMote  Importar al RefMan  Importar al RefiWorks
Recordar mi gestor de bibliografia y mostrar enlaces de importacion en las paginas de

The Forkh resultados de bisqueda he Texto completo UCM
Cornea ar
SH Kidson, '

Mf1, which encodes a winged-helix/forkhead transcription factor, is the murine homolog of
human FKHL7. mutated in individuals with autosomal dominant inherited dysgenesis of the
anterior segment of the eye (Axenfeld-Reiger anomaly). Mouse embryos homozygous for ...
Citado por 118  Articulos relacionados Las 5 versiones Citar Mas~

Development of Dickie's small eye, a mutation in the house mouse

K Theiler, DS Varnum, LC Stevens - Anatomy and embryology, 1979 - Springer

Summary A new semidominant mutation in the laboratory mouse, Dickie’s small eye (Dey),
is descrbed. It is localized on chromosome 2. Heterozygotes show reduced body size, small
eyes with coloboma, small or lacking lens with cataract, abnormal folding of the retina and ...
Citado por 66 Articulos relacionados Las 7 versiones Citar Mas~-

LDL receptor-related protein 5 (LRPS) affects bone accrual and eye development Texto completo UCM




Importar referencias desde Google
Academico

> Abrir EndNoteX2 (no EndNote Web)

o En "Edit” seleccionar “Output Styles™ y "EndNote
Export”

o En "File Menu” seleccionar "Export” Fyle Stile .txty
“Guardar”

> Abrir EndNote Web

o Ira “Collect” y seleccionar “Import references’
o Buscar el fichero guardado

o Seleccionar en “Import option” la opcion “EndNote
Import”, si no estuviera entre las que se despliegan
hay gue seleccionarla en seleccionar faveritos.



| EndNote X2 - [My EndMote Library] E]

Jdournal
Anterior eye development and ocular... Bioessays rti ..
Immunohistochemistry in association...  JMNeurosci ... Journal Arti ..
A direct contact between astrocyte a... Braz d Med... Journal Ari. ..
A practical method for the radicisoto...  JMeurosci ... Journal Ardi ...

Retinal nerve fiber layer thinning in P...  “ision Res Journal Arti .
i Journal At hittpdfAeasnss ncbi onlim.

ur

nlm...

1g 14 of 14 referen
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Referencias para ser exportadas
desde EndNote X2 a EndNoteWeb

ndNote X2 -

My EndMote Librar

| EndMate E=part

|

o @
Title

AlR... (14
Impo... (1)
Trash (8]

= Custom ...

= Smart G...

=- Online S...

Li.. (0)
s)
P.. (O

(0]

More. ..

=- EndMot...
(12
transfer...

Author
Cwakl
Haddad
Haddad
Haddad
Inzelberg
Jdiang
Faram
K aratas
Lamas
Laukb
Li
Lincoff
mammima
Zeng

Anterior eye development and ocular. ..

Jdournal
Bioessays

Ref Type
Journal Arti .

Preview | Search |

a0 Journal Arti
Yo Jdiang, >
oA YL, A

%D 2010

YT One-step a

TN 10
Yol 11
WP T643-7

Export file name:

Guardar en: | ﬂ kiz documentos

E:lnctas Junka Direckores
\Co) Aadministracion Biblioteca General
L) administracion electronica DRI
L) adobesStackPhotos
— ICo) adguisiciones
[ L adqusiciones
LI AMECA
L) Aapoyo docencia & investigacion, Bases de datos
L) Apuntes_ Oposiciones a Faculkativas de Archivos v Bibliokecas_archivas
ICo)Articulos de la Bibliokeca de la ELG. 2005
L) akas Junta directores 2006
L) Aautarizacién para difusion
L avI Splitter
L) Avisos
L) Avudas CM

< |

Documentos
recientes

Escritorio

Miz documentos

L) Baja de mat
ICo)Base de dat
o) Bases de da
L) Eibliografias
L) Bibliokeca inl
L2 Bibliokeca Ur
L) Bibliokeca wil
ICBlogs
EB0E

IE Baletin la Bit
L) Boletines nol
L) BUC Memari
o Tl

L) Calidad

L) Campus wirk

>

MNombre: | b e t =3 |

l Guardar ]

http: Aensnse chi nlm ..

http: Aenense i nlm ..

Mis zitios dered | Tipo: | Text File [*.txt] R |

[ Cancelar ]

Output style: | EndMote E=xport

|

Export Selected References

Prodc T ToT e SYTILNTe ST diil S 2-d552 TR O SThA D TIATTO o Ariicie=.

Yod J Manosci MNanotechnol

b

Showing 14 of 14 references.
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Ayuda en linea

EndMote Web

Table of Contents

General Information

Reaqgistering for Endhote Web
What's Mew

Login and Log Out

Roaming Access

System Reguirements
Accessibility

Troubleshooting
ResearcherlD

Endhote versus Endiote Web

Manage References

Entering References

Editing References

Deleting References

Qick Search

Quick Search Operators
Reference Fields and Size Limits
Full Text and OpenlJRL Linking
Reference Types

Searching Authors

Searching References

Soring References
Synchronization and Transfer with EndiMote

Format References

Biblioaraphy

Bibliographic Style Favorites
Format Paper

Exporting References

Contents | Index | Glossary | Search Help | Search Technical Support | Quick Reference Card

Options

e Changing Password
e Changing E-Mail Address
= Changing User Information

Administrative Customization

Plug-in Installation Options for Administrators

Site Bibliographic Styles
Site Online Search Connections
Site Import Filters

Collect References

Online Search
Online Search Fields
Online Search Operators

Connection File Favorites

Importing References

Import Formats

Import Filter Favaorites

Tab-delimited Import and Export Instructions
Direct Export

Capture

File Attachments

Figure Attachments

Cite While You Write™

Inserting Citations
Format Bibliography
Editing Citations
Unformatting Citations
Export Traveling Library
Removing Field Codes

Training and Support

Tutorials

Endhote Web Forum

Technical Support

Technical Support KnowledgeBase

Organize References

Managing Groups
Creating Groups
Renaming Groups
Deleting Groups

Sharing Groups
Managing Shared Groups
ResearcherlD Groups
Eind Duplicates

Browser Toolbars and Plug-ins

Browser Toolbars

Cite While You Write for Micros oft Word
Installing the EndMote Web Extension for Firefos
Using EndMote Web without Plug-ins

e Internek

L 100%:




EndMote Web

Paginas de ayuda en linea

Contents | Index | Glossary | Search Help | Search Technical Support | Quick Reference Card

Importing References from Thomson Reuters Research Software Products

Importing References from EndNote

If you

Howr do | export a group of references

from these products?

are using EndMote X.0.2 or later, see Transfer with EndMote for an alternative method of moving references between

applications.

1.
2.
3.
4.
L
6.
T
a.

Mote:

Open the library in EndMote.

From the Edit menu, select Qutput Styles.

Select EndNote Export. If EndMote Export is not listed, go to the Style Manager to select it.
Select Export from the File menu.

In the Save As dialog, name the file in the File Mame field and browse to the desired file location.
Confirm the File Type is "Text File (*.txt)"” in the File Format drop-down field.

Click the Sawe button.

In EndMote Web, follow the Import instructions using "EndMote Import” as the filter.

You cannot import the *_enl file directly into EndMote Web. You must follow the steps above to import individual

references or a group of references.

Importing References from Reference Manager

1.
2.
3.
4.
LN
6.
T

Open the database in Reference Manager.

Select Export from the File menu.

In the Export Options dialog, type a file name in the File Name field.

Select the RIS radiobutton in the Output Format panel_

Select the All references in list in the Reference(s) Qption.

Select Export from the File menu.

In EndMote Web, follow the Import instructions using "Refllan RIS ™ as the filter.

Importing References from ProCite

1.

2.
3.
4.

If vou do not have the RIS-EndMote output style, go to ProCite Support to download the file and save it to your
ProCite standard style folder.

Open the database in ProCite.

Select Print Bibliography from the File menu.

On the Bibliography Preview page, select RIS-EndNote from the output style drop-down list box.

Note: If RIS-EndMote_pos is not available, click the browse button (an ellipsis). or Right Arrow button and select
Browse, located to the right of the output style drop-down list box. Select the RIS-EndMote_pos file and click the
Open button.

Clicle o S

EndMote - Select the desired references
in the library window and then select
Show Selected References from the
References menu. Then continue with
the export process.

Reference Manager - Mark the records
firet. Then select Marked Reference
(=) under the References Option panel
in the Export Options dialog.

ProCite - Mark the records first. Then
=elect Marked Records in the Show
drop—-down lizt in the Bibliography
Preview dialog.

e Internek

L 100%:




Importar referencias desde CISNE

> Exportar referencias de CISNE a gestores
bibliograficos: Ref\Works, EndNote, Zotero

o Guia visual
http://complumedia.ucm.es/buscar. php2txthbus
car=#

o EndNote:

Hacer la busgueda en CISNE



http://complumedia.ucm.es/buscar.php?txtbuscar=
http://complumedia.ucm.es/buscar.php?txtbuscar=

Exportar registros desde CISNE

¢{= Universidad Compluiense /Catdlogo - Windows Internet Explorer,

5@ ~  [&] htepipicisne. sim.ucm. esjsearcheSe*spif?searchtype—atsearcharg—salazar-+corr alfsear chscope—6RSORT=DZRextended=Oasearchlimits—ase archarigarg=xFiltras+amarillassaze v | [ 47 || | |

Archiwo  Edicion  Wer  Favoritos  Herramientas  Awoda & Convertir - Seleccionar

T« [@Universidad Complutenss [Catalogo ] ]

peb ~ i Pagina ~ (L Herramientas -

Universidad
Complutense
Madrid

P Cisne. Catalogo de la Biblioteca
La Biblioteca | Buscar | Servid ign Digital Complutense

Metabuscador | Mi Cuenta | Bibliografias | I

|= comenzar |[::Extender

wLimitar |[ S, Otra Basaueda || (Historial de busqueda)

|
[AuTOR

| [salazar corral | [catdlogo complets

[ mMostrar sdélo titulos con ejemplares disponibles

9| (Buscar)

ﬁnEB]UN
[Euardar los registros marcados |\ Guardar todos en pagina 1

S
Entradas ‘WorldCat
Mam Marcar AUTORES (1-2 de 2) Encontradas:
Kanlsrul
2 Caaiogo.
Salazar Corral, Jubn Josa a Wirtual
= I:I‘ Salazar Corral, Ju3dn Jose, dir.

=
[Guardar los|registros marcados \ 1 [

Google
Guardar todos en pagina

académico

M Mavroiio
Comenzar

|[:Extender |[:Limitar || = otra Basqueda || (Historial de busgueda)

1 Buzdn de Sug

Guardar los registros marcados y ,en la siguiente
pantalla, seleccionar “Exportar”

Seleccionar

&P Internet L 100%




Exportar desde CISNE

Universidad Complutense fCatdlogo - Windows Internet Explorer

5-\:‘/): ~  |&] hetpigicisne. sim.ucm.esisearcheSEvspif?asalazar-+carral/-+-+export/1,-1,-1,B/export

Archivo Edicion Wer

& [#2] [3<] [Live search

Fawvoritos  Herramientas  Ayuda @ Convertir -

S ahr [@Universidad Complutenss {Catalogo ] ]

Seleccianar

& - B deby v |2k PAgina - (L Herramientas -
Universidad
Complutense
Madrid

i) T

» Cisne. Catalogo de la Biblioteca
on Digital Complutense

Metabuscador | Mi Cuenta | Bibliografias | Inciden

Comenzar |[:IExtender || < Atras |[LGBorrar

Formato del Listado: Enviar Listado a:
& Pantalla Completa

< E-Mail
O Presentacién Abreviada Enviar a:|
[@)y>)

Asunto:[Busqueda bibliografica en Cisne, Catalogo df
@ End-Mote/Refworks

O Pantalla
% A

@& Disco Local

N r e

Sus registros guardados
Seleccionar TODOS Borrar Todo Borrar seleccionado
MNam Marcar Exportar (1-4 de 4)
1 Anatomofisiologia de la Uvea posterior : coroides J. M. Ramirez, A. 1. Ramirez, J. 1. Salazar, R. de
]

O

] Glioarquitectura de la cabeza del nervio dptico humano [Recursoc electrdnico]
Seleccionar TODOS Borrar Todo Borrar seleccionado

Estudio de las relaciones vaso-gliales en el nervio épt Juan Joseé Salazar Corral ; igida por José M. Ra

Glioarquitectura de la cabeza del nervio éptico humano Juan Jlosé Salazar Corral ; [directores] Jose€ Manue

: Juan José Salazar Corral ;

orarios de las Biblio mpra de un Libro | Buzdn

&P Internet L 100%




Expotar desde Cisne

ﬂ; EndNote Web 2.7 - Windows Internet Explorer E] @

Herramient.

Welcome Maria Jesus 1SI Web of Knowledge= Log Out Help
Web
provided by IS Web of Knowledge™
My References Collect Organize Options
Import
Import References

Importing from EndMNot

_ Import

Elegir la carpeta en donde se quiera guardar

Pulsar “Import”

THOMSON REUTERS

: 2 Inicio B3 Microsoft Excel - Copi... £5 5 Internet Explorer ~| @ 2009 & 200909301 10705705, . . B3 microsoft PowerPoint ... ES Q_,uu\.r.'l 15:01



/= EndMote Web 2.7 - Windows Internet Explorer

@'C/‘ - http: g fendrote . accesowok. Fecyt . s /Endioteiw ebf 2. 7 freleasefEndiot evweh . htrlPFunc=changeFoldersklavacurr entFolder Id= 1 2Z8currentFolderM ame=Masters: V| || = |
Archivo  Edicion  Wer  Fawvoritos  Herramientas  Ayuda &5 convertir  ~ [ Seleccionar

dr afr [E...EndNnteWeb2.7 ] | G- B d=h - [-2 Pagina

1SI Web of Knowledge= | Log Out | Help

End"o iHide message NOTICE:
= i Mew - AP A 5th now available. Refer to these notes

by 151 Wets of i for details e

welcome Maria Jesus

My References Options

Show Getting Started Guide

Quick Search Master

[search for

in [&l References
 Search ) - -
e s (1l [CJPage [Add to group... (]| ( Copy to Quick List Delete Remowe from Group

[Show 10 per page ~| 4 <! page

Hide Panel

Auvuthort Year Title

My References Chang, B. P. 2007 Aan infant with extensive Mongolian spot, naswvus flammeus and cutis marmorata
telangiectatica congenita: a unique case of phakomatosis pigmentowvascularis

All My References (179)
Castrowviejo (10)
Doctorado (85) <8
Glia (0)
marzo (0)

Master (8)

[Unfiled] (76

Quick List (0]

= Unique author identifier
* Generate citation metrics
* Publicize your publications

Kienast, A, K.

Murphy, C. C.

Ramirez, Jose& Manuel

Salazar Corral, Juan

Salazar Corral, Juan

Salazar Corral, Juan

Spitzer, M. S.

Br J Dermatol -

(UG, DEY2s)  Full Text )

Cutis marmorata telangiectatica congenita: a prospective study of 27 cases and
review of the literature with proposal of diagnostic criteria

Clin Exp Dermatol

Late-onset pediatric glaucoma associated with cutis marmorata telangiectatica
congenita managed with Molteno implant surgery: case report and review of the
literature

J AAPOS

LC1 £ENE8s)  Full Text )

Anatomofisiologia de la dwea posterior : coroides

UG, V23,

Estudio de las relaciones wvaso-gliales en el nervio dptico del conejo albino
{Oryctolagus cuniculus)

591.48

UG, V23,

Glicarquitectura de la cabeza del nervio dptico humano : estudio inmunohistoquimico
con anti-PGFA

611.843(043.2)

Online Link* Go to URL

Glioarquitectura de la cabeza del nervio dptico humano Recurso electrdnico : estudio
inmunohistoguimico con anti-PGFA

511.843(043.2)({086)

Online Link=+ Go to URL

UGty Y25,

[Bilateral congenital glaucoma in a child with cutis marmorata telangiectatica
congenita: a case report]

Klin PMonarshl snaenheilkd

http:/fendnote, accesowolk, Fecyt, esfEndioteyebs 2, 7 frelease/Endioteiveb, htmlFFunc=changeFolder shav&currentFolderld=1Z&currentFolder &P Internet
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“Organize” Gestion y organizacion
de referencias

> Creacion de grupos desde "‘manage my
groups Yy en “new group"

xm@%&%aJ@g

i .
Mensaje de usuario de Explorer E| fionsfcat=organizes:

! Menzaje del script:
Enter a Wew Group name and click 'Ok 3
Cancelar

|Glia 1e Maria Jesus 151 Web of Knowledge= | Log Out | Help ) vg:
=
EndNol®" |
provided by 151 Web of Knowledge®
My References Collect Organize Format Options

Manage My Groups Others' Groups Find Duplicates

Manage My Groups

 Number of |
1 RMGEaupSY | References | Share

no groups have been created |
{__New Group |




Organizar:
crear grupos Yy eliminar duplicados

R k=] |

| 7/~ EndMote Web 2.5 - Windows Internet Explorer

=]

Epd http: ffendnote, accesowal. Fecyt. es/EndMotbieb,2. 5irelease/EndMoteteb. htmlFfolderame=Doctoradosf unc=createFolders:

Archivo Edicidn Wer Fawvoritos HerrAmientas Ayuda
' o - [== =i - | S5 i = - [ s
< dJhr B iop Pagina ~ (L0t Herramiertas - (@~ @ 3%

Welcome Maris Jesus ISI Web of Knowledge= | Log Out | Help

Organize Options

Manage My Groups Others' Groups Find Duplicates

Manage My Groups

{ Number of

My Groups# References

Castroviejo {__Manage Sharing Rename | | { Delete )

Doctorado {_Manage Sharing Rename Delete
Glia Manage Sharing | | ( Renams ) | { Delete

_MNew Group

Compartir grupos de referencias con otras personas,
hay que introducir las direcciones de correo electrénico
(tienen que estar en EndNote)

English |

Privacy | Acceptable Use | Download Installers | Feedback

@ 2002 THOMSOMN REUTERS

THOMSON REUTERS

& &P Internst

~ |Haga clic para agregar notas

: pibuje - [ || Auteformas = N ] € 51 <l 2 (@] B | Lp - - -—=a 8
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Format: creacion de bibliografias y
Manuscritos

PEe el T B B f v | R

/= EndMote Web 2.5 - Windows Internet Explorer

B2 Microsoft PowerPoint -

Jfendnot

accesowok. Fecyt.es/Endrotiwsb/,

Gestores bibliograficos. ppt

Jreleass /Endhotetweb. htmlzfunc—bibliography@cat:

archive

e A

Edicién Wer

My References
Bibliography

Favoritos

- B8

E‘!’!ﬂd N o Web

by ISI Web of Knowledge™

Collect

Cite While You Write Plug-In

Herramientas  Ayuda

[;ég - 2 Pagina - \q_(__""_j Herramientas - @— ﬂ &

Organize

Format Paper

Format

Export References

Options

Bibliography
References:
Bibliographic style:

File format:

|- octarade=

[Vancoover

Customize this list

Select...

THT (plain taxt fila) [&

HTML ) {__Preview & Print
T i

plain tesct f
RTF (rich text file)

Examples of Commaonly Used Styles

Area of Study
Sicsciences

Science

Chemistry

Engineering

Humanities

Humanities

General

General

Language and Linguistics
Medicine

Medicine

Medicine

Psychelogy

Sociclogy
Physics/Chemistry

Writing Stvle Guides
CEE

Harvard

ACS

1IEEE

Chicago 15th A or B

Turabian

Annctated

Author-Date

MLA

JAMA

MNLM

ancouver or UNIFORM Reguirements
APA Sth

ASA Style Guide

AIP Style Manual 4th Edition

English

THOMSON REUTERS

Privacy |

Acceptable Use | Download Installers | Feedback

@ 2009 THOMSOM REUTERS

[ € nternet
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Format: Incluir citas en un
manuscrito “Format paper”

ndMote Web 2.5 - Windows Internet Explorer = = ][>

Welcome Maria Jesus ISI Web of Knowledge="

Crganize Options

the EndMote Web Plug-in to ir refarence nd format citat nd bibliogr tom : ur rd. The EndMote

eb Plug-in also allows y we online references to your library in Internet Explorer for

bre:

THOMSON REUTERS

= 5 10 Intern. ~| B Bandejade ... B RE: Revost... & zo09 & 2009 Bl OpticaOfert. .. Ef Opkica PP Fi... BEE MicrasofE P... EsS



Format

> Para Incluir citas o referencias en un
manuscrito con Microsoft Word, hay que
iInstalar "Cite While You Write”, software
de conexion entre EndNote Web y
Microsoft Word

> Una vez instalado aparecera en nuestro
Microsoft Word una barra de herramientas
para la conexion con EndNote Web



Instalacion de la barra de
herramientas

EndNote Web 2.5 - Microsoft Internet Explorer

Archivo Edicidn Ver Favoritos Herramientas Ayuda

@ Atrds T J |ﬂ Iﬁ « ;j fﬁ\l Blisqueda \f;\? Favoritos @ > ! 4 ‘3
Direccidn |@ http:/fendnote. accesowok. fecyt.es/EndMotelWeb /2. 5/release /EndMotelWeb. himl? func=showowyw v| Ir Vinculos
acer - Y_’ - gv | - || Buscar +* &7 Eﬁ £2% Antiespia | 4l Actualizar ya Entrar = [ Correo = @Mi ‘Yahoo! [ﬁ Y1 Respuestas - @Noﬁdas = @.Cine = é@ Musica - >

|| EndMote web 2.5 I =k Afadir pestafia m
~

Welcome Maria lesus 151 Web of Knowledge= | Log Out | Help

Fnd" ) Web

d by IS Web of 5

My References Collect Organize Format
Bibliography | Cite While You Write Plug-In | Format Paper | Export References > M arcar
Cite While You Write Plug-In

Use the EndMote Web Plug-in to insert references, and format citations and bibliographies automatically while you write your papers in Word. The EndNote
Web Plug-in also allows you to save online references to your library in Internet Explorer for Windows.

See Installat e d System Requirements.

Download Windows with Internaf Explorer plug-in
Download Macintosh

wiew in | Sthehzr | English |

0 Internet

j 1SI Web of Knowledg. .. EndMote Web 2.5 -M... ™ Formacion usuarios 2... [€] Microsoft PowerPoint ...




Instalacion de la barra de
herramientas

@Ah’és < J |ﬂ Iﬁ 7;j fﬁ\l Blisqueda \f;\? Favoritos @ 4 J ‘3

Direccidn |@ http:/fendnote. accesowok. fecyt.es/EndMotelWeb /2. 5/release /EndMotelWeb. himl? func=showowyw
acer - Y! - 2|

| ] EndNote web 2.5

v| Ir
v|| Buscar -~ ﬁ Eﬁ {é}.ﬂ.ntiespia

Vinculos
Anctualizar va Entrar = [=JCorrec + @Mi ‘Yahoo! @Y!Respuestas - @Noﬁdas - @.Cine - @Mﬂsia -

r
I sk Afiadir pestafia

[X]
E]

Welcome Maria Jesus

151 Web of Knowledge=* | Log Out | Help

Fnd" ) Web

d by IS Web of 5

Descarga de archivo - Advertencia de segurid
My References Collect Organize
Bibliography Cite While You Write Plug-In

Format Pape] &Desea

Cite While You Write Plug-In Mombre: EndNoteleb.EXE

Use the EndMote Web Plug-in to insert references
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